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LEGAL NOTICE

Warranty

Equipment Limited 
Warranty
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Software Limited 
Warranty

Doble warrants the disks on which the software product is furnished to be free 
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one hundred and twenty (120) days from the date of shipment from Doble.  
Purchaser’s exclusive remedy shall be the replacement of any disks not 
meeting Doble’s Software Limited Warranty which have been returned to 
Doble within the warranty period.
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also have other rights which vary from state to state.
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Remedies
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this agreement. By returning the software product and all copies thereof in any 
form and affirming compliance with this requirement in writing, Doble will 
refund the purchase price.

TO THE EXTENT ALLOWED BY ANY APPLICABLE STATE AND 
FEDERAL LAWS, DOBLE EXPRESSLY DISCLAIMS ALL 
WARRANTIES NOT STATED HEREIN.  IN NO EVENT WILL DOBLE BE 
LIABLE TO PURCHASER FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE ANY SOFTWARE OR PRODUCT, OR FOR ANY 
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Preface

The Sweep Frequency Response Analyzer User Guide explains how to install, 
configure, and operate Doble’s M5200, M5300, and M5400 Sweep Frequency 
Response Analyzer instruments. 

Who Should Read This Guide

This guide is intended for engineers and field testers who work with an 
M5200, M5300, or M5400 Sweep Frequency Response Analyzer. It is 
assumed that the reader is familiar with professional standards and safety 
practices. 

Document Conventions

Typefaces

This document uses special typefaces to indicate particular kinds of 
information:

• Bold Arial type identifies software controls and text you must enter:

Example: Type in 1500 ms.

• Monospaced type identifies text that is displayed in the user interface, 
such as an error message or prompt:

Uploading test results.

Notes and Warnings

This document uses icons to draw your attention to information of special 
importance, as follows.

Notes

NOTE! Notes provide supplemental information that may apply to only 
some circumstances.
72A-2570-01    Rev. K    07/2011 xv
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Cautions

Warnings

CAUTION! Cautions provide information that prevents damage to 
hardware or data.

WARNING! Warnings tell you how to prevent injury or death to anyone 
near the test set or high-voltage equipment.
xvi 72A-2570-01    Rev. K    07/2011



1. Introduction

This chapter describes the SFRA instrument hardware and software and 
introduces SFRA testing. It contains the following sections:

• “M5200, M5300, and M5400 SFRA Instruments” on page 1-1
• “Hardware Accessories” on page 1-3
• “Software” on page 1-4

• “PC Requirements” on page 1-4

M5200, M5300, and M5400 SFRA Instruments
Sweep Frequency Response Analysis (SFRA) testing is a nonintrusive way to 
identify mechanical changes inside a transformer. Changes in the internal 
configuration produce different frequency responses that indicate a range of 
failure modes. Performed in the field, without teardown or draining of oil, 
SFRA testing provides accurate and repeatable measurements. 

The M5200, M5300, and M5400 Sweep Frequency Response Analyzers 
measure and record the frequency-response characteristics of transformer 
windings. Each unit consists of a robust molded shell housing a field 
controller and instrumentation module, an excitation source, and a 
measurement module. Table 1.1 describes the three SFRA instruments.
72A-2570-01    Rev. K    07/2011 1-1
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Figure 1.1  M5200, M5300, and M5400 Instruments

Table 1.1  M5200, M5300, and M5400 Instruments

Name Description Image

M5200 Requires an external 
laptop. Testing functions 
are identical to those of 
the M5300 and M5400.

M5300 Has a built-in laptop, 
keyboard, and display. 
Testing functions are 
identical to those of the 
M5200 and M5400.

M5400 A compact version of the 
M5200 that requires an 
external laptop. Testing 
functions are identical to 
those of the M5200 and 
M5300.
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    1. Introduction 
Hardware Accessories
Table 1.2 describes the standard hardware accessories that come with the 
M520, M5300, and M5400. It also lists an optional test lead.

Table 1.2  Accessories for the SFRA Instruments

Item Description Part No.

Test Leads

Standard lead Length: 18 m/60 ft

Ground: 3.6 m/12 ft

Application: 362 kV

05B-0659-04

Optional lead Length: 30 m/100 ft

Ground: 5.4 m/18 ft

Application: > 362 kV

05B-0659-07

Grounds

Safety ground Length: 9 m/30 ft 02C-0019-01

Ground lead 1.5 m/5 ft 02B-0026-02
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Software
The M5200 and M5400 are controlled by a user-supplied laptop computer 
running Doble SFRA software (supplied with the instrument). The M5300 
comes with a built-in PC, laptop keyboard, and preinstalled Doble SFRA 
software. 

PC Requirements
To see the minimum requirements for the PC used with the M5200 or M5400, 
please go to “PC Requirements” on page E-4.

Communication Cables

USB

No picture available.

Has a square and an 
oblong connector.

181-0585

Ethernet crossover 

No picture available.

Has two Ethernet 
connectors. Required 
for SFRA. SFRA does 
not work with a 
standard network 
cable without a 
crossover adapter.

181-0646

Other Hardware

Clamps Two plain copper 
clamps. These clamps 
connect to larger 
bushing studs or 
terminals that the 
normal connectors do 
not fit. The standard 
test cables then clip to 
these large clamps.

212-0444

Table 1.2  Accessories for the SFRA Instruments

Item Description Part No.
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2. Safety

This chapter reviews the standards and procedures you need to follow to use 
the SFRA instrument safely. It contains the following sections:

• “Overview” on page 2-1

• “General Rules” on page 2-1

• “Grounding Requirements” on page 2-2

• “Personnel Safety Practices” on page 2-3

Overview
Safety cannot be over-emphasized when working on or around high-voltage 
electrical apparatus. Companies that generate, transmit, distribute, or use 
high-voltage electricity should, and do, have precise rules for safe practices 
and procedures. These practices are important for personnel whose working 
responsibilities involve testing and maintaining high-voltage apparatus and its 
associated lines, cables, conductors, and accessories.

General Rules
1. The transformer under test should be completely de-energized and isolated 

from the power system before performing any tests using an M5000-series 
SFRA instrument.

2. The method of testing a high-voltage apparatus (transformer) involves 
exciting the apparatus with the SFRA instrument. Take care to avoid 
contact with the apparatus being tested, its associated bushings and 
conductors, and the SFRA instrument’s cables and connectors.

3. The test crew must make a visual check to ensure that the apparatus 
terminals are isolated from the power system. Because the apparatus under 
test may fail, take precautions (such as barriers or entrance restrictions to 
the test area) to avoid harm in case of violent failure.
72A-2570-01    Rev. K    07/2011 2-1
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4. All of your company rules for safe practice in testing must be strictly 
conformed to, including all practices for tagging and isolating apparatus 
during testing and maintenance work. State, local, and federal regulations, 
e.g., OSHA, may also apply.

Grounding Requirements
The apparatus under test, its tank or housing, and the SFRA instrument must 
be solidly and commonly grounded or earthed. This also applies to any mobile 
equipment being tested. Figure 2.1 shows a sample safety ground connection.

Figure 2.1  Connecting Safety Ground to Transformer

For detailed instructions on grounding the SFRA instrument, go to “Step 2: 
Ground the Transformer” on page 3-12.

Company rules and government regulations take precedence over Doble 
recommendations.

Personal protective equipment suitable for electrical testing of 
transformers is recommended.
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    2. Safety 
Personnel Safety Practices
Make sure that test personnel follow these recommendations:

1. A pretest meeting is recommended. Frequently, other crews will be 
working on non-test-related tasks in close proximity to equipment being 
tested. The pretest meeting should include all personnel who will be 
working in proximity to the area where testing will be performed. In this 
meeting, review with crew members the tests to be performed, apparatus, 
voltage test levels involved, potential hazards, and individual assignments. 
Test personnel need to remain aware of the work activity taking place 
around them and alert to the possibility that non-test personnel may enter 
the test area.

2. Agree on a consistent and uniform set of signals, both visual and verbal. 
All crew members should follow them during testing.

3. While making the various types of connections involved in the tests, it 
may be necessary for personnel to climb up on the apparatus, but no one 
should remain on the apparatus during the test itself.
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3. Setting Up and Running a Test

This chapter describes how to set up hardware and configure software for 
testing and run the test. It also describes typical test results. This chapter 
contains the following sections:

• “Measurement Types” on page 3-1 

• “Step 1: Set Up and Run a Shorted-lead Test” on page 3-2 

• “Step 2: Ground the Transformer” on page 3-12 

• “Step 3: Prepare the Transformer for Testing” on page 3-14

• “Step 4: Select and Run a Test” on page 3-15

• “Sample Test Results” on page 3-25

Measurement Types

Open Circuit

An open-circuit measurement is made from one end of a winding to another, 
with all other winding terminals floating. For a delta winding, connections 
would be H1 to H3, for example. For a star (wye) winding, measurements are 
taken from HV terminals to neutral, such as X1 to X0.

Short Circuit

A short-circuit measurement is made with the same SFRA test lead 
connections as an open-circuit measurement, but with the difference that 
another winding is short- circuited. To ensure repeatability, Doble 
recommends that the three voltage terminals on the shorted winding be shorted 
together. This would mean, for example, shorting X1 to X2, X2 to X3, and X3 
to X1. This ensures that all three phases are similarly shorted, ensuring a 
consistent impedance. Do not include in the shorting process any neutral 
connections available for the shorted winding.
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Step 1: Set Up and Run a Shorted-lead Test
This section describes how to connect the cables to the SFRA instrument and 
perform a basic shorted-lead test. Do not omit this test. If a cable or cable 
connection is bad, this test will save you hours of wasted effort.

Connect the Cable and Leads and Run SFRA 5.2

To connect the ground reference cable and test leads and run SFRA:

1. Follow Figure 3.1 to connect the reference ground and test leads to the 
instrument. This figure shows an M5300, but the connections are correct 
for all three instruments.

Figure 3.1  Cable and Lead Connections to the SFRA Instrument

If you are using an:

• M5200 or M5400—Go to step 2.

• M5300—Power up the M5300 and go to “Create a Transformer 
Listing and Associate a Test Template with It” on page 3-4.

2. Power up the PC. Run the SFRA program by double-clicking the icon or 
selecting StartAll ProgramsDoble EngineeringSFRA.

The main SFRA window opens and displays the Connect to 
Instrument message (Figure 3.2 on page 3-3).

1 BNC yellow, red, and black connectors 4 Green reference ground 2 of 2

2 Instrument ground 5 Red source lead

3 Green reference ground 1 of 2 6 Black measurement lead

1

2

4

3

5

6
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Figure 3.2  Connect to Instrument Message

3. Turn on the SFRA instrument and wait 20 seconds. During this time:

a. The power light comes on. 

b. The Test in Progress and System OK indicator lights come on.

c. The Test in Progress and System OK indicator lights go out.

d. The System OK indicator light comes on and remains lighted.

4. Attach the Ethernet or USB cable to the instrument and the PC.

5. Click the Find Instrument button shown in Figure 3.2.

The Select Instrument window lists all connected instruments (Figure 3.3).

Figure 3.3  Select Instrument Window

NOTE: You can shorten the search time by deselecting any 
communication type that is not in use.
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If no instrument is listed:

• Check the connection between the instrument and the PC. 

• Check the antivirus or firewall software for problems.

• If your instrument is connected to the PC through an Ethernet cable, 
confirm that the PC can see the instrument. To do this, see 
“Confirming the Ethernet Connection” on page 3-30.

6. Click Continue Searching for Instruments.

7. Highlight the instrument desired and click Select Instrument.

The SFRA window displays the Data Manager tab (Figure 3.4). 

Figure 3.4  Data Manager Tab on Main Window

Create a Transformer Listing and Associate a Test Template with It

The shorted-lead test does not have an associated test template and is not 
performed on a transformer. However, SFRA 5.2 test setup requires a 
transformer name, under which the test results will be stored, and an 
associated test template. Therefore, in the following instructions, you: 

NOTE: If the shorted-lead test has already been set up in SFRA 5.2, skip 
this section and go to “Run the Shorted-lead Test” on page 3-8.
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• Create a dummy transformer called Leads

• Select a test template at random and associate it with the Leads 
transformer

To create a dummy transformer and associate a test template with it:

1. In the main window of the SFRA software, open the Edit menu and select 
Edit Apparatus (Figure 3.5).

Figure 3.5  Edit Apparatus Option on Edit Menu

The Test Equipment Editor window opens (Figure 3.6).

Figure 3.6  Test Equipment Editor

2. Click the Edit Transformers button on the right. 

The Transformer Editor window opens, displaying the Transformer tab 
(Figure 3.7 on page 3-6).
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Figure 3.7   Transformer Tab of Transformer Editor Window

3. Click New (Figure 3.7). 

The New Serial Number listing is highlighted (Figure 3.8). 

Figure 3.8  New Serial Number Listing

4. Enter Leads in the Manufacturer field.

5. Enter 0 in the Serial Number field.

6. Click the Test Templates tab. 

Note that the new serial number, 0, appears in the Transformer list 
(item #1 Figure 3.9 on page 3-7).
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Figure 3.9  Test Templates Tab of Transformer Editor Window

7. Click Select (#2 in Figure 3.9).

The Template Editor window appears (Figure 3.10).

Figure 3.10  Template Editor Window

8. Select any test template in the Template list and click OK.

9. Click OK again to close the Transformer Editor window, and click Save 

and Exit to close the Test Equipment Editor.

1

2
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Run the Shorted-lead Test

To run the shorted-lead test:

1. In the main SFRA window, click Select Apparatus.

The Apparatus Selection window appears (Figure 3.11).

Figure 3.11  Apparatus Selection Window

2. Select Leads in the Manufacturer column and click OK.

3. Click Start Test (Figure 3.12).

Figure 3.12  Location of Start Test Button
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The Test Details window appears (Figure 3.13).

Figure 3.13  Test Details Window

4. Short the red source lead and black measurement lead by connecting the 
clamps to each other (Figure 3.14). 

5. Short the green reference grounds by connecting the clamps to each other 
(Figure 3.14).

 

Figure 3.14  Cable Connections for Shorted-lead Test

CAUTION! Do not connect the measurement clamps to 
the ground clamps!

1 BNC yellow, red, and black connectors 4 Green reference ground 2 of 2

2 Instrument ground 5 Red source lead

3 Green reference ground 1 of 2 6 Black measurement lead

1

2

4

3

5

6

72A-2570-01    Rev. K    07/2011 3-9



Sweep Frequency Response Analyzer (SFRA) User Guide
6. Click Run Test.

The Magnitude tab appears (#1 in Figure 3.15) and displays the trace as it 
develops. The Legend pane appears (#2) and a progress bar expands as the 
test progresses (#3).

Figure 3.15  Shorted-lead Test in Progress

When the test finishes, the view auto-zooms so that the trace takes up most 
of the graph. The result should resemble the curve shown in Figure 3.16 
on page 3-11. 

1

2

3
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Figure 3.16  Correct Shorted-lead Response

If the result resembles Figure 3.17, examine the leads for an open circuit. 
The open-circuit response is clearly affected by noise.

Figure 3.17  Open-Circuit Lead Response
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7. When you are satisfied with the test results:

a. Disconnect the test lead clamps from each other.

b. Disconnect the reference ground clamps from each other.

8. Go to “Step 2: Ground the Transformer” on page 3-12.

Step 2: Ground the Transformer
Each time the SFRA test leads are connected, disconnected, or moved, apply 
temporary static-discharge grounds to: 

• The bushings to which the SFRA test clamps will be applied

and 

• Any bushings to which jumpers will be applied

To ground a transformer for SFRA testing:

1. Open the switches to de-energize the transformer and disconnect it from 
the rest of the substation (Figure 3.18). 

Figure 3.18   De-energized and Disconnected Transformer

2. Ground all conductor or bus still connected to the transformer terminals 
outside of the transformer bushings and windings (Figure 3.19). 

 

Figure 3.19  Grounded Transformer
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3. Remove the Isophase or GIS link (Figure 3.20).
 

Figure 3.20  Removed Isophase or GIS Link

4. Apply temporary static-discharge grounds (Figure 3.21).

Figure 3.21  Added Temporary Static-Discharge Grounds

5. Attach the SFRA test leads (Figure 3.22).

Figure 3.22  Connected SFRA Leads

SFRA 
Instrument
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6. Remove temporary static-discharge grounds (Figure 3.23).

Figure 3.23  Removed Temporary Static-Discharge Grounds

7. Isolate terminals not under test and ensure that they are floating, unless 
otherwise specified in the test template. 

Step 3: Prepare the Transformer for Testing
For optimal test results, always follow these practices:

• Make good electrical connections. Clean, file, or wire-brush 
connection points at bushing terminals and bases if necessary.

• Replicate the setup used the last time the transformer was tested. Any 
change in setup affects the consistency of test results. Do not 
change the tap position, DETC position, or core ground connections 
from one test to the next. 

• Ensure that all three phases are solidly shorted together when you 
make short-circuit measurements. 

• Attach the green reference leads to a stud or bolt at the base of the 
bushings under test and ensure that good electrical contact is 
established. Replicate the positions of the reference leads on all three 
bushings, if possible, to eliminate reference variation as a source of 
measurement.

• Record all relevant information, including tap position, oil level, test 
lead position (Black/Red), and terminals of other windings (grounded 
or shorted).

SFRA 
Instrument
3-14 72A-2570-01    Rev. K    07/2011



    3. Setting Up and Running a Test 
Step 4: Select and Run a Test
By running the shorted-lead test, you have already followed the complete 
procedure for running a test. This section provides a testing procedure for a 
transformer that has already been set up in SFRA and associated with a test 
template.

Requirements for This Test

Complete these actions before you run a test:

1. Perform the shorted-lead test. Do not omit it. To run the test, go to “Step 
1: Set Up and Run a Shorted-lead Test” on page 3-2. 

2. Set up the transformer in SFRA. To do this, go to “Entering a Transformer 
into the SFRA Database” on page 5-5.

3. Ground the transformer. Do not omit this procedure. If you have not 
already done so, go to “Step 2: Ground the Transformer” on page 3-12.

4. Prepare the transformer for testing. If you have not already done so, go to 
“Step 3: Prepare the Transformer for Testing” on page 3-14.

Associate the Transformer with a Test Template

A transformer must be associated with a test template before it can be tested. 
To do this:

1. In the main window of the SFRA software, open the Edit menu and select 
Edit Apparatus (Figure 3.24).

Figure 3.24  Edit Apparatus Option on Edit Menu

The Test Equipment Editor window opens (Figure 3.25 on page 3-16).
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Figure 3.25  Test Equipment Editor

2. Click the Edit Transformers button on the right. 

The Transformer Editor window opens, displaying the Transformer tab 
(Figure 3.26).

Figure 3.26   Transformer Tab of Transformer Editor Window
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3. Click the Test Templates tab (Figure 3.27). 

Figure 3.27  Test Templates Tab of Transformer Editor Window

4. Click Select.

The Template Editor window appears (Figure 3.28).

Figure 3.28  Template Editor Window

5. Select the template in the Template list and click OK.
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6. Click OK again to close the Transformer Editor window, and click Save 

and Exit to close the Test Equipment Editor.

SFRA Test Procedure

To run an SFRA test on a transformer:

1. In the main SFRA window, click Select Apparatus.

The Apparatus Selection window appears (Figure 3.29).

Figure 3.29  Apparatus Selection Window

2. Select the serial number of the transformer in the Manufacturer column 
and any other options you wish. The items you select remain highlighted 
as shown in Figure 3.29. Click OK.
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3. In the Apparatus and Test pane, click Select Test (Figure 3.30).

Figure 3.30  Location of Select Test Button

The Test Selection window displays the tests contained in the template 
(Figure 3.31).

Figure 3.31  Test Selection Window
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4. Click Start Test (Figure 3.32).

Figure 3.32  Location of Start Test Button

The Test Details window appears (Figure 3.33).

Figure 3.33  Test Details Window

5. Following the directions under the Red Lead Location and Black Lead 
Location headings in the template, connect the test leads and enter notes if 
required. 
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6. Do one of the following:

• To perform a nonstandard test, go to step 7.

• To perform a standard template test, skip to step 10 on page 3-22.

7. To perform a nonstandard test, select the Advanced Setup check box in 
the Test Details window (Figure 3.33 on page 3-20).

A warning message appears (Figure 3.34).

Figure 3.34  Nonstandard Test Warning

8. Click OK.

The Test Details dialog box expands to display an Advanced Test Protocol 
section on the right (Figure 3.35).

Figure 3.35  Test Details Dialog Box with Advanced Test Protocol
72A-2570-01    Rev. K    07/2011 3-21



Sweep Frequency Response Analyzer (SFRA) User Guide
9. At the top of the Advanced Test Protocol section, click the option button 
for Expanded Range or Start: Stop: Step and make the desired selections.

10. Click Run Test.

11. The instrument first runs four self-tests to assess the condition of the 
setup. If it detects a problem, it may return one or more errors or warnings. 
For more information, see “Self-Test Error and Warning Messages” 
on page 3-22.

Self-Test Error and Warning Messages

The SFRA self-test can produce the following error and warning messages:

• Error 950—Internal temperature exceeds acceptable limits. 
M5000 instruments are designed to operate in a 50° C/ 122° F 
environment for extended periods. A high temperature may reduce 
component life and instrument reliability. If error 950 occurs, turn the 
instrument off and allow it to cool down before continuing the test. 

• Error 951—Noise levels on the test leads exceed safe levels for the 
instrument. Excessive input noise may damage the instrument or 
cause excessive noise in the results. If error 951 occurs, stop the test, 
ground the bushing terminals momentarily to discharge stored energy, 
and restart the test. You can continue the test without changing your 
setup, but results may be noisy and in severe cases the instrument may 
be damaged.

• Alert 952—Resistance between ground connections exceeds 1 ohm 
and may be too high (Figure 3.36). 

Figure 3.36  Alert 952
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Excessive ground-loop resistance affects the shape of the traces, 
especially at higher frequencies. Acceptable values depend on lead 
length:

• 18 m (60 ft) leads—A value of less than 1 ohm is ideal. Attempt to 
clear the alert by checking all ground connections and restarting 
the test. Continuing to test with ground resistance above 1 ohm 
may compromise the results. 

• 30 m (100 ft) leads—Results are normally as high as 1.5 ohms; if 
the resistance shown is below 1.5 ohms, continue the test. If the 
resistance shown exceeds 1.5 ohms, check all ground connections 
and restart the test. Continuing to test with ground resistance 
above 1.5 ohms may compromise results. 

Causes of high ground-loop resistance include poor connections to 
bushing studs because of dirt, grease, or paint, or, occasionally, the 
stud itself not being grounded. Consider any measurement above 
250 ohms an open circuit. If Alert 952 occurs, ensure that all 
connections are good. 

• Error 953—The internal M5000 performance check was 
unsuccessful (Figure 3.37). 

Figure 3.37  Error 953

The instrument generates signals at a number of frequencies and 
measures them without sending them through the test object. This 
signal verification test confirms that the device is performing as 
expected. If the test fails, results will be compromised. You are not 
allowed to continue the test. Contact Doble Engineering for 
troubleshooting and repair. 
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If each test is successful, the test begins and the Magnitude tab appears (#1 
in Figure 3.38 on page 3-24) and displays the trace as it develops. The 
Legend pane appears (#2) and a progress bar expands as the test 
progresses (#3).

Figure 3.38  Test in Progress

When the test finishes, the view auto-zooms so that the trace takes up most of 
the graph. 

Troubleshooting Test Results

SFRA is an easy test to perform, but simple problems can occur during a test. 
These have characteristic signatures, as described below.

Monitoring Waveforms

The instrument allows you to monitor the reference and measured waveforms 
as you run through a test. Click the Waveform tab to display waveforms. Both 
waveforms should appear. At very low dB response, the measured waveform 
may be small.

1

2

3
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Diagnosing Open-Circuit Response

An open-circuit response may be caused by the black test lead dropping off the 
bushing, a poor connection, or damage within the test lead. The discrete 
change in the lower frequency range in Figure 3.39 on page 3-25 shows 
typical open-circuit behavior: about –90 to –100 dB. Investigate a test like this 
to see if the open circuit lies in the test setup or the transformer.

Figure 3.39  Typical Open-Circuit Trace

Sample Test Results
This section provides typical results from a number of transformer windings 
and designs. These are examples of how designs and phase results vary 
between transformers.

Three Responses for One Transformer

Figure 3.40 on page 3-26 shows the two open-circuit responses and the 
short-circuit response of one phase of an autotransformer. The three traces are 
clearly different at low frequencies.

Typically, the HV response starts at a much lower level than the LV response. 
The short-circuit response approaches 0 dB at low frequency but comes back 
in line with the HV response at higher frequencies.
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Figure 3.40  Responses for One Phase of a Transformer HV Delta Trace

Figure 3.41 shows the responses for three phases of a HV delta winding. This 
is a characteristic response at low frequencies:

• The center phase has a slightly higher impedance (more negative 
response) at lower frequencies.

• The center phase is different from the outer phases at the first 
resonance below 10 kHz.

• The center phase is similar to the outer phases as frequency rises.

• All three phases have the same basic shape above about 100 kHz.

Figure 3.41  HV Delta Winding Traces

1 Short Circuit

2 Open Circuit LV

3 Open Circuit HV

1

3

2
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HV Wye (Star) Response

Figure 3.42 shows a typical HV wye (star) winding response. All three phases 
show similar responses at low frequencies, with the following characteristics:

• The center phase has a slightly increased impedance (more negative 
dB) at low frequencies.

• The center phase has one resonance and the outer phases two. The 
outer phases are similar at low frequencies.

• The three phases come back together as frequencies approach 10 kHz.

• The three phases show regions of similarity and regions of 
dissimilarity across the frequency range.

Figure 3.42  HV Wye Winding Trace

Short-Circuit Test Response

Figure 3.43 on page 3-28 shows the three short-circuit responses from the HV 
side of a transformer. As expected, the responses are similar.
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Figure 3.43  Short-Circuit Test Trace

Even when responses are shown in magnification (Figure 3.44), they are under 
the average divergence of 0.2 dB among phases. This is a useful diagnostic 
where no previous results are available.

Figure 3.44  Short Circuit Trace – Detail
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Repeat Results for One Phase at Different Times

The two responses in Figure 3.45 were taken 18 months apart. The original 
data was taken as a baseline set of results; the subsequent data was taken after 
an incident involving the transformer. The results are similar.

Figure 3.45  Repeat Results for One Phase

Low-frequency variation, below about 5 kHz, is characteristic of core 
magnetism affecting the results. The traces have the same basic shape, but one 
is offset compared to the other. They come back into line as they approach 
10 kHz.

The higher-frequency results are almost identical. This is strong evidence that 
there has been no change in this transformer.

Results Showing a Shorted Turn

A shorted turn produces an effect similar to shorting the low-side windings for 
a short-circuit measurement. The effect is easy to see at low frequencies and 
does not require reference results.

The original results show the characteristic low-frequency response of a wye 
(star) winding. The subsequent results, taken a year later after a close-in fault, 
show the characteristic response of a short somewhere on that phase.
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Figure 3.46 shows an example of a shorted turn on one winding.

Figure 3.46  Shorted Turn on One Winding

Confirming the Ethernet Connection

To confirm that the PC is connected to the instrument using the Ethernet 
connection:

1. Click the Start button in the lower left corner of the Windows Desktop.

The Start menu appears (Figure 3.47).

Figure 3.47  Start Menu
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2. In the field at the bottom of the Start menu, type CMD.

The search runs instantly and displays results immediately as you type.

3. Press Enter.

The Command window appears.

4. At the prompt, type ipconfig (item #1 in Figure 3.48) and press Enter.

The network information that is displayed includes your IP address.

Figure 3.48  Command Window Displaying IP Address

5. Look at DNS suffix (item #2 in Figure 3.48):

• enet.m5200—This suffix confirms that the instrument is connected to 
the PC. If SFRA still cannot find the M5000 instrument, contact your 
Doble representative for assistance.

• Anything else—Any other suffix indicates that instrument is not 
communicating with the PC. Check the cable connections. If this does 
not solve the problem, you may want to contact your IT department 
for assistance with network connections. If they are functioning 
correctly, contact your Doble representative for assistance.

1

2
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4. Managing Tests and Templates

This chapter describes the templates provided with SFRA 5.2 and explains 
how to use them. It contains the following sections:

• “Introduction” on page 4-1

• “Opening the Template Editor” on page 4-1

• “Creating a New Test Template” on page 4-2

• “Editing or Deleting a Template” on page 4-3

• “Adding, Editing, or Deleting Tests in a Template” on page 4-3

Introduction
SFRA software provides preconfigured templates in the Settings folder. A test 
template provides a list of recommended tests for a transformer. You can edit 
these template files, replace them, or import other templates using a simple 
procedure to merge template files (see “Merging Settings Files” 
on page 5-14).

The Template Editor enables you to create, edit, review, and delete test 
templates. Test templates are a means of grouping tests for a particular 
transformer design and are a flexible way to specify tests for use in the field. 
You can associate a template with a number of transformers or create it for 
future reference and not associate it with any transformer.

For information about the specific contents of each template, see Appendix B, 
“Test Templates.”

Opening the Template Editor
To open the Template Editor:

1. Open the Edit menu and select Edit Apparatus.

The Test Equipment Editor window opens.

2. Click the Edit Templates button.

The Template Editor window opens (Figure 4.1 on page 4-2).
72A-2570-01    Rev. K    07/2011 4-1



Sweep Frequency Response Analyzer (SFRA) User Guide
Figure 4.1  Template Editor

Creating a New Test Template
To create a new test template:

1. In the Template Editor window, click New.

A New Template appears in the Template List.

2. Enter a name in the Name field (required) and a description if desired.

3. Click Manage or right-click a row or heading of the Test Settings table and 
click Manage.

The Test Setting Editor appears (Figure 4.2 on page 4-3).
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Figure 4.2  Test Setting Editor

4. Enter the appropriate settings. Red Lead and Black Lead are required.

5. Click OK.

Editing or Deleting a Template
To edit or delete a test template:

1. In the Template Editor window, select the template from the Template 
List.

2. Click Manage or right-click a row or heading of the Test Settings table and 
click Manage.

The Test Setting Editor appears.

3. To edit a template, edit the contents of the fields on the right.

4. To delete a template, select it from the Template List and click Delete.

The Confirm Delete dialog box appears.

5. Click Yes.

6. Click OK.

Adding, Editing, or Deleting Tests in a Template
The Test Setting Editor enables you to add, edit, or delete tests in a template.

To open the Test Setting Editor:

1. Open the Edit menu and select Edit Apparatus.

The Test Equipment Editor window opens.
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2. Click the Edit Templates button.

The Template Editor window opens.

3. Click Manager.

The Test Setting Editor window opens (Figure 4.2 on page 4-3).

The name of each available test appears in the Test Setting List. The 
minimum required information is the position of the red lead (e.g., H1, A, 
or N) and the black lead (e.g., X0, n, or v). Together, these values provide 
the name of the test in the Test Setting List.

Creating a New Test Setting

To create a new test setting:

1. In the Test Setting Editor, click New.

New Red, New Black appears in the Test Setting List.

2. Enter the appropriate settings. Red Lead and Black Lead are required.

3. Click OK.

Editing or Deleting a Test Setting

To edit or delete a test setting:

1. In the Test Setting Editor, select the test from the Test Setting List.

2. To delete a test, select it and click Delete.

The Confirm Delete dialog box appears.

3. Click Yes.

4. To edit, edit the contents of the fields on the right.

5. Click OK.
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5. Managing Data and Generating Reports

This chapter explains how to fill in the nameplate, create and maintain test 
templates, and manage results data. It contains the following sections:

• “Managing Location Information” on page 5-1

• “Adding or Deleting SFRA Instrument Information” on page 5-3

• “Adding or Deleting Organization Information” on page 5-4

• “Managing Transformer Information” on page 5-5

• “Managing Tap Changer Data” on page 5-7

• “Managing Results Data” on page 5-8

Managing Location Information
The location is the place, such as a substation, where the SFRA transformer 
test is performed. Location files store all location information in an XML file. 
SFRA enables you to add or delete location data, and to export or import 
location files.

To manage location information:

1. In the main window of the SFRA software, open the Edit menu and select 
Edit Apparatus.

The Test Equipment Editor window opens (Figure 5.1 on page 5-2).
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Figure 5.1  Test Equipment Editor

2. Click New Location to add information (Figure 5.2).

The words New Location appear in the Location field and the Location 
List. 

Select and delete these words in the Location field and type in the new 
location.

Figure 5.2  Entering a New Location 

SFRA software enables you to import and export Location files. This 
helps ensure consistency of locations for different users. 
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3. To export a location file:

a. Select the location in the Location List.

b. Click Export To Location File.

The Save As dialog box appears.

c. If desired, enter a new filename in the File Name field.

d. Click Save.

4. To import a Location file:

a. Click Import From Location File.

The Open dialog box appears.

b. If necessary, navigate to the appropriate folder on your computer.

c. Select the file.

d. Click Open.

The Import From Location dialog box appears.

e. Click OK.

5. To delete a location, select the location and click Delete Location.

6. Save all changes by clicking Save and Exit.

Adding or Deleting SFRA Instrument Information
The Test Equipment List displays the serial numbers of Doble SFRA 
instruments that have been added into the SFRA database.

To add a serial number:

1. In the main window, open the Edit menu and select Edit Apparatus.

The Test Equipment Editor window opens (Figure 5.1 on page 5-2).

2. Click New Equipment (Figure 5.3).

Figure 5.3  Entering a New Serial Number 
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The words New Serial Number appear in the Test Equipment List and 
Serial Number field. 

3. Select and delete these words in the Serial Number field and type in the 
new serial number.

4. To delete a serial number, select the number in the Test Equipment List 
and click Delete Equipment.

5. Save all changes by clicking Save and Exit.

Adding or Deleting Organization Information
The organization is the owner of the transformer to be tested. 

To add organization information in this window:

1. In the main window of the SFRA software, open the Edit menu and select 
Edit Apparatus.

The Test Equipment Editor window opens (Figure 5.1 on page 5-2).

1. Click New Organization.

The words New Company appear in the Test Organization List and 
Company field. 

2. Select and delete these words in the Company field and type in the new 
company name (Figure 5.4).

Figure 5.4  Entering a New Organization

3. To delete an organization, select it in the Test Organization List and click 
Delete Organization.

4. Save all changes by clicking Save and Exit.
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Managing Transformer Information
The Transformer Editor enables you to create, edit, review, and delete detailed 
information about transformers. 

To add or edit transformer information: 

1. In the main window of the SFRA software, open the Edit menu and select 
Edit Apparatus.

The Test Equipment Editor window opens (Figure 5.1 on page 5-2).

2. Click the Edit Transformers button on the right.

The Transformer Editor window opens (Figure 5.5).

Figure 5.5  Transformer Tab of Transformer Editor Window

Entering a Transformer into the SFRA Database

To enter a transformer into the SFRA database:

1. Click New.

The words New Serial Number appear in the Transformer List.
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2. Select a manufacturer from the drop-down menu on the Transformer tab. 
This is a required field. If the manufacturer name is not available, select 
No MFR Listed.

3. Enter the serial number of the transformer. This is a required field. Each 
transformer must have a unique serial number; this is its key identifier.

4. Enter any other desired data on the Transformer tab or edit existing data.

5. Click OK.

Editing or Deleting Transformer Data

To edit or delete data about a transformer:

1. Select the transformer from the Transformer List.

2. To delete this transformer, click Delete.

3. To edit the information, edit the contents of the fields.

4. Click OK.

Cloning a Transformer

Cloning duplicates an existing transformer, so you can create a new entry 
without having to reenter all the data. Only the serial number is required.

To clone a transformer:

1. Click Clone.

The Edit Serial Number dialog box appears (Figure 5.6).

Figure 5.6  Edit Serial Number Dialog Box
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2. Enter a new serial number.

3. Click OK.

4. Make any other necessary edits on the Transformer Editor tabs.

5. Click OK.

Importing and Exporting Transformer Files

SFRA software allows you to import and export Transformer files. This helps 
ensure consistency for different users. The files are saved in .XML format.

To export a transformer file:

1. Select the transformer from the Transformer List.

2. Click Export To Transformers File.

The Save As dialog box appears.

3. If desired, enter a new filename in the File Name field.

4. Click Save.

To import a transformer file:

1. Click Import From Transformers File.

The Open dialog box appears.

2. If necessary, navigate to the appropriate folder on your computer.

3. Select the file.

4. Click Open.

The Import From Transformers File dialog box appears.

5. Click OK.

Managing Tap Changer Data
The LTC/DETC tab (Figure 5.7 on page 5-8) enables you to enter data 
associated with any load tap changer (LTC) or de-energized tap changer 
(DETC) that may be present on the transformer. This is not required but is 
useful reference data.

The Range fields are used to indicate the full range available for the LTC or 
DETC.

The position of the tap changer during a test is recorded in a separate table 
when a test is made.
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Figure 5.7  LTC/DETC Tab of Transformer Editor Window

Managing Results Data
This section explains how to store, export, and import data; transfer data files 
between machines; work with settings files; and configure and generate 
reports.

Default Data Locations

The Sweep Frequency Response Analyzer Settings dialog box (Figure 5.8 on 
page 5-9) enables you to change the folder for data from tests (Data Path) and 
the various Editors (Editors List Path).
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Figure 5.8  Sweep Frequency Response Analyzer Settings Dialog Box

To change the location of a data folder or template file:

1. Select Edit Options.

The Sweep Frequency Response Analyzer Settings dialog box 
(Figure 5.8) appears.

2. Click the ellipsis button at the right of the path you want to change.

The Browse For Folder dialog box appears (Figure 5.9).

Figure 5.9  Browse for Folder Dialog Box

3. Navigate to the desired folder and click OK.

4. Click OK.

Selecting a Data Source

To select a folder for viewing data:

1. To search for files in all subfolders of the data folder, check the Search All 

Sub-Folders check box on the Data Manager tab.
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Test results are date- and time-stamped and saved to the default folder 
automatically. You can set up additional data folders based on 
transformers, substations, manufacturers, or any other category.

2. To make the folder you select the default folder, click the Make Folder 

Default button.

3. Click Browse for Folder.

The Browse For Folder dialog box appears (Figure 5.9 on page 5-9).

4. Navigate to the desired folder.

5. Click OK.

The files appear in the Data Grid.

6. Click the plus sign to the left of a category in the Data Tree to display the 
options for viewing a subset of data in that category.

Click Refresh Data Tree if you select a new data source or add SFRA 
traces to the default folder while the software is open.

To rearrange the order of the columns in the Data Grid, click on a column 
head and drag it to the desired location.

7. Select one or more traces to view, using standard Windows commands to 
select the rows of interest. (For instructions, see “Data Manager Tab” 
on page A-11). 

8. Click Display Traces.

9. View the traces on the Magnitude, Phase, or Impedance tabs.

Export Selected Results to .CSV Files

You can save test files in .CSV format for use in spreadsheets or the M5100 
software viewer.

To save test files in .CSV format:

1. Select the file(s) in the Data Manager tab, using standard Windows 
commands to select the items of interest. (For instructions, see “Data 
Manager Tab” on page A-11)(For instructions, see “Data Manager Tab” 
on page A-11).

2. Click Export Selected Results To CSV Files.

The Files Converted dialog box appears (Figure 5.10 on page 5-11).
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Figure 5.10  Files Converted Dialog Box

3. Click OK.

Import Location and Transformer from Results Files

You can add the Location and Transformer entries from a file to your own 
settings files (LocationList.xml and TransformerList.xml in the 
Settings folder).

To import Locations and Transformers from data files:

1. In the Data Manager tab, select the files from which you wish to import 
locations and transformers. Use standard Windows commands to select 
the items of interest. (For instructions, see “Data Manager Tab” 
on page A-11).

2. Click Import Location and Transformer From Results File.

If a Location or Transformer is imported, a Location Data Copied or 
Transformer Data Copied dialog box displays the name(s) of the imported 
Location or Transformer.

If a Location or Transformer is not imported — typically because it is 
already in your settings files or is in the wrong format — a No 
Transformers Imported or No Locations Imported dialog box appears.

3. Click OK for each dialog box.

Saving and Deleting Traces

All completed traces are automatically saved to the default data location you 
can select in “Default Data Locations” on page 5-8. If the test is canceled, the 
data is not saved.

The SFRA software has no Delete option. To delete files, locate the file using 
the time-stamp in the folder where it is stored and delete it in Windows 
Explorer. The filename appears as the last column of each row in the Data 
Manager tab.
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Automatic save and the procedure for deleting files are set up to help protect 
data from inadvertent replacement or loss.

Importing 1.x and 2.x M5100 SFRA Files

You can import data from M5100 versions 1.x and 2.x software by placing 
those files in the appropriate data source location. When opened, they will be 
parsed for content, converted to the new Doble SFRA format, and renamed 
with a different extension so as not to be reconverted subsequently. Be sure to 
back up copies of these files as a precaution against data loss.

Nameplate data in M5100 versions 1.x and 2.x format is not easily converted 
to M5200/M5300/M5400 format. A number of fields are the same, such as 
Transformer Serial Number and Location, but the location of test leads may be 
less obvious. Check imported data for accuracy and details, with no odd 
characters in any field, such as @, *,? etc.

Transferring Data between Machines or PCs

To transfer data between machines or PCs, copy the desired files to a network 
or suitable medium and use Windows Explorer to navigate to them in the 
target machine.

The software will try to identify duplicate files but is not foolproof. Make sure 
to retain a backup when copying and importing data.

Settings Files

Settings files contain entered data for:

• Transformers

• Locations

• Test Organizations

• Test Instrument

• Test Templates

The files are in XML format. To locate them on your computer, select Edit 
Options. The Sweep Frequency Response Analyzer dialog box (Figure 5.8 on 
page 5-9) displays the file paths.

To open a settings file, use a standard text editor such as Notepad. Do not use 
Microsoft Word or other word processors, because they will attempt to save 
files in their native formats, which are typically not compatible with SFRA 
software. This document assumes the use of Notepad.
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Figure 5.11 displays a simplified view of a Transformer settings file that will 
be used to describe the file in detail.

Figure 5.11  Simplified XML Transformer Settings File

• Line 1 is always the XML declaration that describes the XML version 
and encoding used. This must not be modified.

• Line 2 contains a start tag that is the beginning of the container of all 
transformers in the file. It must have a matching end tag (line 107).

Line # XML Code

1 <?xml version="1.0" encoding="utf-8"?>

2 <transformerNameplates>

3   <transformerNameplate version="1">

4     <manufacturer>ABB</manufacturer>

5     <serialNumber>1234</serialNumber>

-     .

-     .

-     .

54   </transformerNameplate>

55   <transformerNameplate version="1">

56     <manufacturer>GE</manufacturer>

57     <serialNumber>xyz</serialNumber>

-     .

-     .

-     .

106   </transformerNameplate>

107 </transformerNameplates>

Line numbers apply only to this example—they will vary for other settings 
files. What is important is the XML start and end tags for each section.
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• Line 3 contains the start tag of the first transformer nameplate and 
must also have an end tag (line 54). 

• Line 55 shows the start of another transformer, which ends on line 
106.

• If another transformer were added, it would appear after line 106 and 
before </transformerNameplates> on line 107.

Merging Settings Files

The method for merging transformer settings files described here applies to all 
other settings files.

The following example concerns two SFRA users who want to share XML 
files.

Figure 5.12 shows a simplified transformer settings file from User A (as 
viewed in Notepad):

Figure 5.12  Transformer Settings File — User A

Use caution when merging, because an incorrect merge could corrupt 
your files and cause unpredictable results. Be especially careful to avoid 
duplicate entries in any settings file.

The manual merge described here is prone to cut-and-paste errors. Back 
up all data and settings files before performing a merge operation.

<?xml version="1.0" encoding="utf-8"?>

<transformerNameplates>

<transformerNameplate version="1">

<manufacturer>ABB</manufacturer>

<serialNumber>1234</serialNumber>

</transformerNameplate>

<transformerNameplate version="1">

<manufacturer>GE</manufacturer>

<serialNumber>678</serialNumber>

</transformerNameplate>

</transformerNameplates>
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Figure 5.13 shows another simplified transformer settings file, this one from 
User B:

Figure 5.13  Transformer Settings File — User B

User A’s file contains two transformers (underlined in the tables for clarity):

• ABB, with serial number 1234

• GE, with serial number 678

User B’s file contains one transformer: ACME, with serial number 9999.

The safest method for merging is to combine the two files into a new file 
containing elements from both source files. The following procedure merges 
the contents into a new transformer settings file. It makes use of the fact that 
several versions of Notepad can be run simultaneously.

To merge settings files:

1. Back up all TransformerList.xml files.

2. Start an instance of Notepad and open User A’s TransformerList.xml 
file.

3. Start another instance of Notepad and open User B’s 
TransformerList.xml file.

4. Start a third instance of Notepad.

5. Select the entire text in User A’s file and paste it into the blank Notepad.

6. Close User A’s file.

7. Select just the transformerNameplate section from User B’s file 
(Figure 5.14 on page 5-16).

<?xml version="1.0" encoding="utf-8"?>
<transformerNameplates>

<transformerNameplate version="1">

<manufacturer>ACME</manufacturer>

<serialNumber>9999</serialNumber>

</transformerNameplate>

</transformerNameplates>
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Figure 5.14  TransformerNameplate Section of User B’s Settings File

8. Close User B’s file.

9. In the remaining Notepad, place the cursor at the beginning of line 3 and 
paste the text.

10. Check that the file has the correct format, with carriage returns and 
indents, to ensure readability of the document.

11. Save the file as TransformerList.xml.

12. Replace the existing TransformerList.xml file, either by saving the 
new file to in the default location or by dragging and dropping or copying 
using Windows Explorer.

Reports

The Reports feature of SFRA provides a variety of options that enable you to 
include only the information types you want. 

To configure and print a report:

1. Display the traces you wish to include in the report.

2. Open the File menu and select Configure Report.

The Report Designer window appears (Figure 5.15 on page 5-17).

<transformerNameplate version="1">

<manufacturer>ACME</manufacturer>

<serialNumber>9999</serialNumber>

</transformerNameplate>
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Figure 5.15  Report Designer Window

3. Select the report options you prefer and do any of the following:

• Click Save this Design. This saves the selections you have made in 
the Report Designer window and applies them to any report you create 
in the future. These settings can be edited at any time.

• Click Preview Report. You can expand the Print Preview window to 
read the text more easily, and you can click the printer icon to print the 
report.
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A. Software Overview

This appendix explains how to install SFRA 5.2 and the appropriate USB 
driver and provides a complete overview of the SFRA 5.2 user interface. It 
contains the following sections:

• “Installing SFRA 5.2” on page A-1

• “Manually Install the USB Driver” on page A-5

• “SFRA 5.2 Software Overview” on page A-6

• “Apparatus/Test and Legend Panes” on page A-10

• “Tab Divisions in SFRA” on page A-11

Installing SFRA 5.2
These instructions explain how to install SFRA 5.2 under Windows 7 and 
Windows XP. You must have administrator privileges to install under either 
operating system. 

To install SFRA 5.2:

1. Download the software from the Doble web site or run the installation CD 
provided by Doble.

2. Do one of the following:

• Windows 7—Right-click setup.exe and select Run as administrator.

• Window XP—Double-click setup.exe.

Note: You can install SFRA 5.2 under Vista by following the steps provided 
for Windows 7, but SFRA software is not tested under Vista and 
compatibility is not assured.
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The Welcome screen appears (Figure A.1).

Figure A.1  Welcome Window of Setup Wizard

3. Click Next.

The Select Installation Folder window appears (Figure A.2).

Figure A.2  Select Installation Folder Window

4. Make the following selections:

• Accept the default folder or browse to a folder of your choice.

• Choose Just Me if you are installing SFRA on your personal 
computer.

• Choose Everyone if you are installing SFRA on a general-use 
machine.
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5. Click Next. 

The Confirm Installation window appears (Figure A.3).

Figure A.3  Confirm Installation Window

6. Review your installation choices and go back to change them or click Next 
to confirm them.

A progress bar appears (Figure A.4).

Figure A.4  Progress Bar in Installation Window

7. When the installation is complete, click Close.

Two initial setup choices are made the first time the software is run.
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8. Run SFRA 5.2 by double-clicking the icon on the desktop or running the 
program from within the Start menu.   

A message window asks whether your instrument is an M5300 
(Figure A.5).

Figure A.5  Identifying an M5300

9. Click Yes or No as appropriate.

The Select Default Template window appears (Figure A.6).

Figure A.6  Select Default Template Window

10. Select the appropriate template and click Open.

If you have installed SFRA 5.2 over an earlier version of SFRA, the word 
legacy is appended to the names of your existing templates.

Installation and initial setup of SFRA 5.2 is complete. 

NOTE: For SFRA 5.2 to work with USB communications, the correct driver 
must be installed. Go to “Manually Install the USB Driver” on page 5 to 
ensure that the correct driver is installed.
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Manually Install the USB Driver
It is crucial that you manually install a specific USB driver for your SFRA 
instrument. Do not rely on any pre-installed drivers that came with Windows. 

Where to Find the Driver

Made by Silicon Laboratories, the USB driver can be found in these locations:

• On the SFRA V5.2 CD.

• On a Doble FTP site. Doble provides different FTP sites for Internet 
Explorer Version 6 and Internet Explorer Version 7 or 8:

• IE V6—ftp://Dobleguest:Dob20066@ftp.doble.com. 
Navigate to the SiLab driver folder and download the driver to any 
location on your hard drive. 

• IE V7 or 8—ftp://ftp.doble.com/dobleguest/SiLab/. 
Download the driver to any location on your hard drive.

Remove Previously Installed USB Drivers

To avoid conflicts, remove all previously installed Silicon Laboratories 
CP210x VCP drivers before installing the new one. The following procedure 
is for Windows 7; the procedure may vary slightly for other versions of the 
Windows operating system. 

To remove previous versions of the USB driver:

1. Open the Start Menu and select the Control Panel.

2. In the Control Panel window, select Programs and Features.

3. In the Uninstall or Change a Program window, select and remove any 
earlier version of the Silicon Laboratories CP210x VCP driver that may be 
installed.

Install the Driver

To install the driver on your PC, double-click the CP210xVCPInstaller file and 
follow the installation prompts.
72A-2570-01    Rev. K    07/2011 A-5



Sweep Frequency Response Analyzer (SFRA) User Guide
SFRA 5.2 Software Overview
This section provides a complete reference of all SFRA software controls. To 
find a control, look it up in the following tables by its physical location in the 
user interface, or look it up in the Index of this manual to find the page 
number.

File Menu

The File menu has no Save command, because all traces are automatically 
saved upon completion. Table A.1 lists and describes the File menu options.

Edit Menu

Table A.2 lists and describes the Edit menu options.

Table A.1  File Menu Options

Command Description

Print Opens the standard Windows Print dialog box. 
Shortcut key: Ctrl + P

Print Preview Previews the print format for the plot shown on the 
Magnitude tab. Click the up or down arrow at the 
upper right corner of the Preview window (to the right 
of the Page field) to view each page. Shortcut key: 
Ctrl + Shift + P

Exit Exits the program. Shortcut key: Alt + F4

Table A.2  Edit Menu Options

Command Description

Edit Apparatus Opens the Test Equipment Editor dialog box, enabling 
you to enter or edit apparatus, location, and company 
details.

Options Opens the Sweep Frequency Response Analyzer 
Settings dialog box, enabling you to change the default 
location of test data and editor lists.
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Test Init Menu

Table A.3 lists and describes the Test Init menu options.

Graph Menu

To pan a graph, press Ctrl and use the left mouse button to drag the trace 
across the screen. 

Table A.4 lists and describes the Graph menu options.

Table A.3  Test Init Menu Options

Command Description

Select Apparatus Opens the Apparatus Selection dialog box, enabling 
you to select an apparatus for a test.

Start Test Starts a test. Active only after you use Select 
Apparatus to choose an Apparatus/Location 
combination.

Table A.4  Graph Menu Options

Command Description

Cursor 1 Displays a blue crosshair cursor on the Magnitude, 
Phase, or Impedance graph. You can also click the blue 
“+” field in the status bar to activate the cursor. 
Coordinates appear in the blue “+” field of the status bar. 
The cursor attaches to the nearest graph. Click and drag 
either cursor line to move it.

Cursor 2 Displays a red crosshair cursor on the Magnitude, Phase, 
or Impedance graph. You can also click the red “+” field 
in the status bar to activate the cursor. Coordinates 
appear in the red “+” field of the status bar. The cursor 
attaches to the nearest graph. Click and drag either cursor 
line to move it.

Center Cursors Centers the cursor crosshairs in the graph. This is the 
center of the scale values, which may be offset on a log 
scale.
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Zoom Zooms on the graph section between cursor positions. 
Both cursors must be visible. Shortcut key: Shift + click. 
You can also shift, click, and drag diagonally to create a 
rectangle outlining the area you want to zoom on.

Unzoom Resets the graph to the default view.

New Range Opens the Plot 
Range dialog box, 
enabling you to 
set the low and 
high axis limits. 
This is useful 
when producing 
zoomed plots of 
graph areas for 
reports.

Log Displays the graph with a log x-axis scale. Typically 
emphasizes lower frequencies.

Linear Displays the graph with a linear x-axis scale. Typically 
emphasizes higher frequencies.

Table A.4  Graph Menu Options (Continued)

Command Description
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Help

Table A.5 describes the Help menu options.

Clear Traces Opens the Clear 
Traces dialog 
box, allowing 
you to remove 
one or more 
traces from the 
display. Check 
the boxes of the 
traces you wish 
to remove and 
click OK.

Clearing traces 
is different from 
checking or unchecking boxes in the Legend pane, which 
leaves the trace there but merely shows or hides it on the 
tab. Clearing the trace here removes it from the Legend 
pane.

Table A.4  Graph Menu Options (Continued)

Command Description

Table A.5  Help Menu Options

Command Description

Help Opens the help file.

About Opens the version information and copyright dialog 
box. The software version and build number are in the 
upper right corner. If your PC is connected to an 
instrument or if you are using an M5300, the 
Instrument Firmware Information field displays the 
instrument firmware version and related information.
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Apparatus/Test and Legend Panes
Click the appropriate tab at the lower left of the main SFRA window to 
display the Apparatus/Test pane and the Legend pane.

Apparatus and Test Pane

Use the Apparatus and Test pane at the left of the main screen to select a 
transformer for test, set basic test parameters, and start a test. Subsequently, 
this pane shows which frequency is being measured and the progress of the 
test. When using an M5200 or M5400, this pane is active only when 
connected to the instrument.

Legend Pane

The Legend pane enables you to show or hide graphs on the Magnitude, 
Phase, and Impedance tabs and to set their properties. Check or uncheck the 
box at the left of the graph name to show or hide the trace. Right-click on a 
trace name and click Plot Property to display the Plot Property dialog box 
(Figure A.7).

Figure A.7  Plot Property Dialog Box

Use the drop-down menus to change the color, line style, and width of the plot. 
Interference Cancellation filters the results if they contain noise. It applies 
only to plot views and does not alter the saved data. Leave it checked unless 
you need to identify noise frequencies within the results. This option is not 
available with results from M5100 version 1.x or 2.x software.
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Tab Divisions in SFRA
This section describes the main tab divisions of the SFRA 5.2 user interface.

Data Manager Tab

The Data Manager tab (Figure A.8) displays test files grouped by folders 
(default or user-defined), with controls to select, display, and export those 
files.

Figure A.8  Data Manager Tab

To select a row in this window, click in the grey column to the left of the row 
of interest. Use the standard Windows commands for selecting multiple 
contiguous rows or non-contiguous rows:

• To select two or more contiguous rows—Click the gray section at the 
left of the first desired row, hold down the Shift key, and click the gray 
section at the left of the last desired row.

• To select several non-contiguous rows, hold down the Ctrl key and 
click the gray section at the left of each desired row.
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Magnitude Tab

The Magnitude tab (Figure A.9) displays magnitude versus frequency for the 
selected graph(s).

Figure A.9  Magnitude Tab

Figure A.10 shows the status bar at the bottom of the main screen. The 
coordinates reflect the last change you made to the cursor position on any of 
the three tabs. Click the blue or red “+” sign to show or hide the cursors. The 
field on the right (active only when both are on) displays the difference 
between the two.

Figure A.10  Status Bar
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Phase Tab

The Phase tab (Figure A.11) displays phase versus frequency for the selected 
graph(s). Phase is rarely used but can occasionally be useful when looking at 
whether a measurement is more inductive or more capacitive.

Figure A.11  Phase Tab

Figure A.12 shows the status bar at the bottom of the main screen. The 
coordinates reflect the last change you made to the cursor position on any of 
the three tabs. Click the blue or red “+” sign to show or hide the cursors. The 
field on the right (active only when both are on) displays the difference 
between the two.

Figure A.12  Status Bar
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Impedance Tab

The Impedance tab (Figure A.13) displays Impedance (Z ohms) and 
Admittance (Y Mhos) representations, using the magnitude and phase results 
for calculation. Use the option button at the lower left to select the desired 
display type.

Figure A.13  Impedance Tab

Figure A.14 shows the status bar at the bottom of the main screen. The 
coordinates reflect the last change you made to the cursor position on any of 
the three tabs. Click the blue or red “+” sign to show or hide the cursors. The 
field on the right (active only when both are on) displays the difference 
between the two.

Figure A.14  Status Bar
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Sub-Band Tab

The Sub-Band tab (Figure A.15) is included for historical continuity. Early 
work on SFRA required results displayed on graphs of 2 kHz, 20 kHz, 200 
kHz, and 2 MHz. The last three of these are included here to permit viewing 
those graphs.

Figure A.15  Sub-Band Tab
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Waveform Tab

The Waveform tab (Figure A.16) is useful when monitoring the progress of a 
measurement: it displays both the reference waveform generated by the test 
set and the measured waveform of the object under test. This tab displays a 
waveform only when a test is in progress. 

It is also possible to use the Waveform tab to help diagnose a bad connection, 
which will appear as a low, noisy, non-sinusoidal signal.

Figure A.16  Waveform Tab
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Analysis Tab

The Analysis tab (Figure A.17) enables you to compare two traces. The upper 
pane displays the two traces you select; the lower pane displays the difference 
between them.

Figure A.17  Analysis Tab
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Tabulation Tab

The Tabulation tab (Figure A.18) displays graph data in tabular form. Check a 
box in the Legend pane to display the values for that graph.

Figure A.18  Tabulation Tab
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Apparatus Tab

The Apparatus tab (Figure A.19) displays test setup, apparatus location, and 
transformer nameplate information related to the trace selected in the Legend 
pane.

Figure A.19  Apparatus Tab
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B. Test Templates

This appendix provides complete details for the test templates included with 
SFRA 5.2. It contains the following sections:

• “Introduction” on page B-1

• “Notes About the Test Templates” on page B-1

• “Two-Winding Transformers” on page B-2

• “Autotransformers” on page B-3

• “Three-Winding Transformers” on page B-4

Introduction
The test templates given here require the performance of open-circuit and 
short-circuit tests.

A standard set of tests, recorded when a baseline is needed and there is no 
question of the transformer’s health, consists of a set of results taken only at 
extreme tap position. Doble recommends that the LTC be in the extreme raise 
position. However, if the transformer is being tested for post-event reasons, 
such as fault, this should be done in the as-found LTC position. Note the tap 
positions on the test report and apply them during the start of each test.

Doble recommends leaving the DETC in the as-found position. The DETC 
position should not be moved for an SFRA test until all options are exhausted. 
For new transformers in the factory, use the nominal DETC position, unless 
otherwise specified by the end-user.

Notes About the Test Templates
Keep the following information in mind as you refer to the test templates:

• Leads. Each table gives the recommended tests with the position of 
the red lead and black lead clearly identified. Reversing these test 
leads may provide small variations in higher-frequency response. 
Therefore, take care to attach test leads appropriately.
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• LTC position. Changing LTC affects SFRA response. Before you 
move the tap changer into neutral position, record the previous tap 
position so that you can identify possible influences from the LTC 
reversing switch.

• DETC position. Transformers in service occasionally have problems 
due to DETC movement. Doble does not recommend altering the 
DETC position for an SFRA test. The exception is in factory tests on a 
new transformer, where it can be assumed that the DETC is in 
operating condition and tests can be performed on nominal tap.

Two-Winding Transformers

*   Indicates short-circuit tests where the terminals are shorted together with three 
sets of jumpers, to provide symmetry (X1-X2, X2-X3, X3-X1) OR (Y1-Y2, 
Y2-Y3, Y3-Y1). The neutral is not included for 3 wye connections, but may 
be included for 1 test connections.

Table B.1  Two-Winding Transformers — 9 Tests

Test Type Test #

3
Delta-
Wye 

3
Wye- 
Delta 

3
Delta-
Delta 

3
Wye-
Wye 1

HV Open Circuit 
(OC)

All Other Terminals 
Floating 

Test 1 H1-H3 H1-H0 H1-H3 H1-H0 H1-H2(H0)

Test 2 H2-H1 H2-H0 H2-H1 H2-H0

Test 3 H3-H2 H3-H0 H3-H2 H3-H0

LV Open Circuit 
(OC)

All Other Terminals 
Floating

Test 4 X1-X0 X1-X3 X1-X3 X1-X0 X1-X2(X0)

Test 5 X2-X0 X2-X1 X2-X1 X2-X0

Test 6 X3-X0 X3-X2 X3-X2 X3-X0

Short Circuit (SC)

High (H) to Low (L)

Short [X1-X2-X3]*

Test 7 H1-H3 H1-H0 H1-H3 H1-H0 H1-H2(H0)

Short

X1-X2(X0)*
Test 8 H2-H1 H2-H0 H2-H1 H2-H0

Test 9 H3-H2 H3-H0 H3-H2 H3-H0
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Autotransformers

*   Indicates short-circuit tests where the terminals are shorted together with three 
sets of jumpers, to provide symmetry (X1-X2, X2-X3, X3-X1) OR (Y1-Y2, 
Y2-Y3, Y3-Y1). The neutral is not included for 3 wye connections but may 
be included for 1 test connections.

Table B.2  Autotransformer without Tertiary or with Buried Tertiary — 
9 Tests

Test Type Test # 3 1

Series Winding (OC)

All Other Terminals 
Floating 

Test 1 H1-X1 H1-X1

Test 2 H2-X2

Test 3 H3-X3

Common Winding (OC)

All Other Terminals 
Floating

Test 4 X1-H0X0 X1-H0X0

Test 5 X2-H0X0

Test 6 X3-H0X0

Short Circuit (SC)

High (H) to Low (L)

Short [X1-X2-X3-X1]*

Test 7 H1-H0X0 H1-H0X0

Short

[X1-H0X0]*
Test 8 H2-H0X0

Test 9 H3-H0X0

Table B.3  Autotransformer With Tertiary — 18 Tests 

Test Type Test # 3 1

Series Winding (OC)

All Other Terminals Floating

Test 1 H1-X1

H1-X1Test 2 H2-X2

Test 3 H3-X3

Common Winding (OC)

All Other Terminals Floating

Test 4 X1-H0X0

X1-H0X0Test 5 X2-H0X0

Test 6 X3-H0X0

Tertiary Winding (OC) 

All Other Terminals Floating

Test 7 Y1-Y3
Y1-Y2

(Y1-Y0)
Test 8 Y2-Y1

Test 9 Y3-Y2
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Three-Winding Transformers

Short Circuit (SC)

High (H) to Low (L)

Short (X1-X2-X3-X1)

Test 10 H1-H0X0 X1-H0X0

Short 
[X1-H0X0]

Test 11 H2-H0X0

Test 12 H3-H0X0

Short Circuit (SC)

High (H) to Tertiary (Y)

Short (Y1-Y2-Y3-Y1)

Test 13 H1-H0X0
X1-H0X0

Short [Y1-Y2]
Test 14 H2-H0X0

Test 15 H3-H0X0

Short Circuit (SC)

Low (L) to Tertiary (Y)

Short (Y1-Y2-Y3-Y1)

Test 16 X1-H0X0
H1-H0X0

Short [Y1-Y2]
Test 17 X2-H0X0

Test 18 X3-H0X0

Table B.3  Autotransformer With Tertiary — 18 Tests  (Continued)

Test Type Test # 3 1

Table B.4  Three-Winding Transformer Table – 18 Tests (Part 1)

Test Type Test #

3
Delta-
Delta-
Delta

3
Delta-
Delta-
Wye

3Delta-
Wye-
Delta

3
Delta-
Wye-
Wye

1

HV Open Circuit (OC) 

All Other Terminals 
Floating 

Test 1 H1-H3 H1-H3 H1-H3 H1-H3
H1-H2

(H1-H0)
Test 2 H2-H1 H2-H1 H2-H1 H2-H1

Test 3 H3-H2 H3-H2 H3-H2 H3-H2

LV Open Circuit (OC)

All Other Terminals 
Floating 

Test 4 X1-X3 X1-X3 X1-X0 X1-X0
X1-X2

(X1-X0)
Test 5 X2-X1 X2-X1 X2-X0 X2-X0

Test 6 X3-X2 X3-X2 X3-X0 X3-X0
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*   Indicates short-circuit tests where the terminals are shorted together with three 
sets of jumpers, to provide symmetry (X1-X2, X2-X3, X3-X1) OR (Y1-Y2, 
Y2-Y3, Y3-Y31). The neutral is not included for 3 wye connections but may 
be included for 1 test connections.

Tert Open Circuit (OC)

All Other Terminals 
Floating

Test 7 Y1-Y3 Y1-Y0 Y1-Y3 Y1-Y0
Y1-Y2

(Y1-Y0)
Test 8 Y2-Y1 Y2-Y0 Y2-Y1 Y2-Y0

Test 9 Y3-Y2 Y3-Y0 Y3-Y2 Y3-Y0

Short Circuit (SC)

High (H) to Low (L)

Short [X1-X2-X3-X1]*

Test 10 H1-H3 H1-H3 H1-H3 H1-H3 H1-H0

Short

[X1-X2]*

Test 11 H2-H1 H2-H1 H2-H1 H2-H1

Test 12 H3-H2 H3-H2 H3-H2 H3-H2

Short Circuit (SC)

High (H) to Tertiary (T)

Short [Y1-Y2-Y3-Y1]*

Test 13 H1-H3 H1-H3 H1-H3 H1-H3 H1-H0

Short

[Y1-Y2]*

Test 14 H2-H1 H2-H1 H2-H1 H2-H1

Test 15 H3-H2 H3-H2 H3-H2 H3-H2

Short Circuit (SC)

Low (L) to Tertiary (T)

Short [Y1-Y2-Y3-Y1]*

Test 16 X1-X3 X1-X3 X1-X0 X1-X0 X1-X0

Short

[Y1-Y2]*

Test 17 X2-X1 X2-X1 X2-X0 X2-X0

Test 18 X3-X2 X3-X2 X3-X0 X3-X0

Table B.4  Three-Winding Transformer Table – 18 Tests (Part 1) (Continued)

Test Type Test #

3
Delta-
Delta-
Delta

3
Delta-
Delta-
Wye

3Delta-
Wye-
Delta

3
Delta-
Wye-
Wye

1

Table B.5  Three-Winding Transformer Table – 18 Tests (Part 2)

Test Type Test #

3Wye-
Wye-
Wye

3Wye-
Wye-
Delta

3Wye-
Delta-
Wye

3Wye-
Delta-
Delta

HV Open Circuit (OC) 

All Other Terminals 
Floating 

Test 1 H1-H0 H1-H0 H1-H0 H1-H0

Test 2 H2-H0 H2-H0 H2-H0 H2-H0

Test 3 H3-H0 H3-H0 H3-H0 H3-H0
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*   Indicates short-circuit tests where the terminals are shorted together with three 
sets of jumpers, to provide symmetry (X1-X2, X2-X3, X3-X1) OR (Y1-Y2, 
Y2-Y3, Y3-Y1). The neutral is not included for wye connections.

LV Open Circuit (OC)

All Other Terminals 
Floating 

Test 4 X1-X0 X1-X0 X1-X3 X1-X3 

Test 5 X2-X0 X2-X0 X2-X1 X2-X1

Test 6 X3-X0 X3-X0 X3-X2 X3-X2 

Tert Open Circuit (OC)

All Other Terminals 
Floating

Test 7 Y1-Y0 Y1-Y3 Y1-Y0 Y1-Y3 

Test 8 Y2-Y0 Y2-Y1 Y2-Y0 Y2-Y1 

Test 9 Y3-Y0 Y3-Y2 Y3-Y0 Y3-Y2 

Short Circuit (SC)

High (H) to Low (L)

Short [X1-X2-X3-X1]*

Test 10 H1-H0 H1-H0 H1-H0 H1-H0

Test 11 H2-H0 H2-H0 H2-H0 H2-H0

Test 12 H3-H0 H3-H0 H3-H0 H3-H0

Short Circuit (SC)

High (H) to Tertiary (T)

Short [Y1-Y2-Y3-Y1]*

Test 13 H1-H0 H1-H0 H1-H0 H1-H0

Test 14 H2-H0 H2-H0 H2-H0 H2-H0

Test 15 H3-H0 H3-H0 H3-H0 H3-H0

Short Circuit (SC)

Low (L) to Tertiary (T)

Short [Y1-Y2-Y3-Y1]*

Test 16 X1-X0 X1-X0 X1-X3 X1-X3 

Test 17 X2-X0 X2-X0 X2-X1 X2-X1 

Test 18 X3-X0 X3-X0 X3-X2 X3-X2 

Table B.5  Three-Winding Transformer Table – 18 Tests (Part 2) (Continued)

Test Type Test #

3Wye-
Wye-
Wye

3Wye-
Wye-
Delta

3Wye-
Delta-
Wye

3Wye-
Delta-
Delta
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C. Theory of Operation

This appendix presents the theoretical underpinnings of SFRA testing. It 
contains the following sections:

• “Transformer Damage and SFRA Testing” on page C-1

• “How SFRA Identifies Damage to Transformers” on page C-2

• “Test Cable Lengths” on page C-4

• “Transformer” on page C-5

Transformer Damage and SFRA Testing
Although power transformers are specified to withstand the mechanical forces 
arising from shipping and subsequent in-service events, damage sometimes 
still occurs.

• Transportation damage can occur if the clamping and restraints are 
inadequate; such damage may lead to core and winding movement. 

• In-service damage can occur from events such as faults and lightning. 
The most severe in-service forces arise from system faults and are 
axial and radial in nature. If the forces are excessive, radial buckling or 
axial deformation can occur. With a core form design, the principal 
forces are radially directed, whereas in a shell-form unit, they are 
axially directed. This difference is likely to influence the types of 
damage found.

Once a transformer is damaged, even if only slightly, its ability to withstand 
further short circuits is reduced. Utility personnel need to identify such 
damage. Most methods have distinct drawbacks. Visual inspection is costly 
and does not always produce the desired results. During a field inspection, the 
oil has to be drained, and confined-entry rules apply. Since so little of the 
winding is visible, little damage can be seen, other than displaced support 
blocks. Often, a complete teardown is required to identify the problem. 
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There is a relationship between the geometric configuration of the internals of 
a transformer and the distributed electrical elements inside the winding and 
core assembly. These elements can be represented as an RLC network, and 
such a network will have a frequency dependent transfer function. Changes to 
the geometric configuration will affect the impedance of the RLC network, 
and thus produce a different frequency response.

How SFRA Identifies Damage to Transformers
The primary objective of SFRA is to determine how the impedance of a test 
specimen behaves over a specified range of frequencies. The impedance is a 
distributive network of real and reactive electrical components. The components 
are passive and can be modeled by resistors, inductors, and capacitors. The 
reactive properties of a given test specimen depend on, and are sensitive to, 
changes in frequency. The change in impedance versus frequency can be dramatic 
in many cases. This behavior becomes apparent when we model impedance as a 
function of frequency. The result is a transfer function representation of the RLC 
network in the frequency domain.

Frequency response analysis is generally applied to a complex network of passive 
elements. For practical purposes, we will consider only resistors, inductors, and 
capacitors as passive circuit elements, and they are assumed to be ideal. These 
three fundamental elements are the building blocks for various physical devices, 
such as transformers, motors, generators, and other electrical apparatus.

It is important to understand the difference between the physical device and the 
mathematical model we intend to use. When large and complex systems are 
electrically analyzed, we are often faced with a poorly defined distributed 
network. A distributed network contains an infinite number of infinitely small 
RLC elements. For example, transmission lines are generally distributed in nature.

It is practical to model such distributed systems by lumping the basic RLC 
components together, resulting in a lumped network. Lumping elements together 
for a single frequency is a trivial task, but when system modeling requires 
spanning a significant frequency interval, producing a suitable lumped model 
becomes difficult.

When a transformer is subject to SFRA testing, the leads are configured to use 
four terminals. These four terminals can be divided into two unique pairs—one 
pair each for the input and output. These terminals can be modeled in a 
two-terminal pair or a two- port network configuration (<Hypertext>Figure C-1).
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Figure C-1  Two-Port Network

Solving for the open-circuit impedance for each lumped element forms the 
impedances Z11, Z22, Z12, and Z21. It should be noted that the negative 
terminals are short- circuited when transformers are tested. The transformer tank 
is common for both negative and lower terminals. The transformer tank and lead 
ground shields must be connected together to achieve a common-mode 
measurement. This assures that no external impedance is measured. Applying the 
connection in this manner helps reduce the effects of noise. It is important to 
obtain a zero impedance between the lower or negative terminals to assure a 
repeatable measurement.

The transfer function of an RLC network is the ratio of the output and input 
frequency responses when the initial conditions of the network are zero. Both 
magnitude and phase relationships can be extracted from the transfer function. 
The transfer function helps us better understand the input/output relationship of a 
linear network. The transfer function also represents the fundamental 
characteristics of a network and is a useful tool in modeling such a system.

The transfer function is represented in the frequency domain and is denoted by the 
Fourier variable H(j), where (j) denotes the presence of a frequency-dependent 
function, and = 2f. The Fourier relationship for the input/output transfer 
function is given by:

When a transfer function is reduced to its simplest form, it generates a ratio of two 
polynomials. The main characteristics, such as half-power and resonance, of a 
transfer function occur at the roots of the polynomials.

The goal of SFRA is to measure the impedance model of the test specimen. When 
we measure the transfer function H(j), it does not isolate the true specimen 
impedance
Z(j). The true specimen impedance Z(j) is the RLC network, which is 
positioned between the instrument leads, and it does not include any impedance 
supplied by the test instrument.

+ +

– –

Z12

Z22

Z21

Z11

Iin

Vin

Iout

Vout

H j 
Voutput j( )

Vinput j( )
----------------------------=
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It must be noted that when using the voltage relationship, H(j) is not always 
directly related to Z(j). For Z(j) to be directly related to H(j), a current must 
be substituted for the output voltage and then ohm’s Law can be realized. 
However, SFRA uses the voltage-ratio relationship to determine H(j). Since 
SFRA uses a 50-ohm impedance- match measuring system, the 50-ohm 
impedance must be incorporated into H(j). The next equation shows the 
relationship of Z(j) to H(j):

It is often useful to plot the magnitude and phase relationship of the transfer 
function in logarithmic format. The units of magnitude and phase are in decibels 
(dB) and degrees, respectively. Magnitude and phase are represented as follows:

This format takes advantage of the asymptotic symmetry by using a logarithmic 
scale for frequency. Plotting the phase relationship with the magnitude data helps 
determine whether the system is resistive, inductive, or capacitive. It is often 
useful to compare resonance in the magnitude plots with the zero crossings in the 
phase relationship.

Test Cable Lengths
The cables and connectors supplied with the M5000 instruments are made from 
low- loss RG-58 RF coaxial cable, with the shields grounded to the instrument 
chassis through a standard connector. The instrument requires a matched 
impedance signal cable and performs a single-end measurement—that is, the 
signal is measured with respect to the instrument ground. The shield of the signal 
cable must be connected to the chassis using a 50-ohm impedance-matched RF 
BCN connector. The test leads should not be modified in any manner.

Practical field experience indicates that the leads be 18 m / 60 ft. This is the 
shortest length useful to test the largest transformers from a location on the 
ground, adjacent to the unit. Nevertheless, lead length determines the maximum 
effective frequency.

The standard cable shield grounds connect the cable shields to the transformer 
ground at the base of the bushing. These ground connections are 3.6 m / 12 ft back 
from the terminal connection, on the measurement ends of the cables. If this is not 
long enough to reach from the bushing terminal to the base of the bushing, a 
30 m / 100 ft  cable is available, with ground connections 5.4 m / 18 ft back from 
the terminal connection.

H j  50
Z j( ) 50+
--------------------------=

A dB  20 10 H j ( )log=

A   1–tan H j ( )=
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Transformer
SFRA tests measure only the RLC network of the transformer. To maintain 
consistency and repeatability of measurements, make sure that all terminals 
not under test are isolated and floating. To maintain a balanced and 
symmetrical approach, where a delta winding is completed and grounded 
external to the transformer tank, the delta should be complete but floating. 
Such windings are frequently used for regulation; where such windings are 
grounded internal to the tank, it is necessary to leave that ground in place — 
but we should expect asymmetry in the results.

We could measure a frequency response with the remaining terminals 
grounded, but it could not be compared to a response measured with floating 
terminals, which would display a different RLC response.
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D. Repairs and Replacement Parts

This appendix provides instructions for replacing a fuse and part numbers for 
replacement parts and accessories. It contains the following sections:

• “Replacing a Fuse” on page D-1

• “Repairs” on page D-3

• “Replacement Parts” on page D-3

Replacing a Fuse
The fuses are located above the AC power connector on the front of the SFRA 
instrument. Figure D.1 shows the location in an M5400. 

Figure D.1  Location of Fuses on M5400
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To replace a fuse:

1. Insert a flat blade behind the top of the fuse cover (Figure D.2).

Figure D.2  Blade in Top of Fuse Cover

The fuse cover is hinged at the bottom.

2. Pull the fuse cover out and down (Figure D.3).

Figure D.3  Open Fuse Cover with Fuses in Place

Note that the arrows on the fuses match the arrows printed on the inside of 
the cover.

3. Replace the fuses, making sure to match the arrows on the fuses to the 
arrows on the cover, and close the cover. 
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Repairs
All repairs to the SFRA instruments must be done by Doble.

For support, contact Doble customer service at 617-926-4900 or email 
customerservice@doble.com.

Before returning an instrument to Doble, call or email Doble customer service 
to receive an RMA number. Return the unit in padded, protective packaging. 

The shipping address is:

Customer Service Manager
Doble Engineering Company
85 Walnut Street
Watertown, MA 02472-4037
USA

Replacement Parts
Contact Doble Customer Service to order replacement parts. 

M5200 and M5400

Table D.1 lists cables and adapters available for use with the M5200 and 
M5400. 

Table D.1  M5200 and M5400 Cable and Adapter Parts List

Qty Description Part No.

1 Bag, Cable, Large 2FB-3449-01

1 Cable, Ground, 9 m / 30 ft, M4K / M2H / 
MEU

02C-0019-01

4 Cable, Ground, 1.5 m/5 ft 02B-0026-02

1 Cable, RJ45 / Cat 5E, Crossover, 2 m / 7 ft 181-0646

1 Cable, Specimen Test, 18 m / 60 ft 05B-0659-04

1 Cable, Specimen Test, 30 m / 100 ft 05B-0659-07

1 Cable, USB, A/B, 1.8 m / 6 ft 181-0585

2 Clip, Solid Copper, 400A 212-0444
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Table D.2 lists other components shipped with the M5200 and M5400.

1 Cord, Power Country-specific. 
Contact your Doble 
representative.

Table D.2  M5200 and M5400 Additional Components

Qty Description Part No.

1 CD, SFRA, Product Information 08A-0151-01

1 CD, SFRA Software 08A-0152-01

2 M5200 Fuse: 3.0 Amp, 250 V, 3 AG, 
SLO-BLO

384-0002

2 M5400 fuse: 0.75 Amp, 250 V, 3 AG, 
Slo-Blo

384-0084

1 SFRA Quick Start Guide 72A-2499-01

1 SFRA User Guide 72A-2570-01

Table D.1  M5200 and M5400 Cable and Adapter Parts List (Continued)

Qty Description Part No.
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    D. Repairs and Replacement Parts 
M5300

Table D.3 lists cables and adapters available for use with the M5300. 

Table D.4 lists other components shipped with the M5300.

Table D.3  M5300 Cable and Adapter Shipping/Replacement List

Qty Description Part No.

1 Bag, Cable, Large 2FB-3449-01

1 Cable, Ground, 9 m / 30 ft, M4K / M2H / 
MEU

02C-0019-01

4 Cable, Ground, 1.5 m / 5 ft 02B-0026-02

1 Cable, Specimen Test, 18 m / 60 ft 05B-0659-04

1 Cable, Specimen Test, 30 m / 100 ft 05B-0659-07

2 Clip Solid Copper, 400A 212-0444

1 Cord, Power Country-specific. 
Contact your Doble 
representative.

Table D.4  M5300 Additional Components

Qty Description Part No.

2 Fuse: 3.0Amp, 250 V, 3 AG, 
SLO-BLO

384-0002

1 USB Keyboard 401-0295
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E. M5200/M5300/M5400 Technical 
Specifications

This appendix provides specifications for the M5200, M5300, and M5400 
instruments. It contains the following sections:

• “Instrument Specifications” on page E-1

• “Lead Specifications” on page E-3

• “PC Requirements” on page E-4

Instrument Specifications
These specifications apply to all three SFRA instruments.

NOTE! Specifications are subject to change without notice.

Table E.1  Instrument Specifications

Feature Definition

Excitation Source

Channels 1

Frequency Range 10 Hz to 25 MHz

Output Voltage 20 V peak-to-peak at 50 ohms

Output Protection Short-circuit protected

Source Impedance 50 ohms

Calibration Interval 3 years

Measurement Channels

Channels 2
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Sampling Simultaneous

Frequency Range 10 Hz to 25 MHz

Max. Sampling rate 100 MS/s

Input Impedance 50 ohms

Calibration Interval 3 years

Data Collection

Test Method Sweep frequency

PC Communication USB/Ethernet

Frequency Range 10 Hz to 25 MHz

Number of Points 1000 (default); up to 1800 (extended range)

Point Spacing 1.2% logarithmic

Dynamic Range >90 dB

Repeatability ±1 dB to –80 dB

IF Bandwidth < 10% of active frequency

Data Display

Scaling Linear/Log

Frequency Range 10 Hz to 25 MHz, user-defined within frequency 
range

Plotting Frequency vs. magnitude / phase

Analysis Difference, Sub-band cross-correlation

Physical Specifications

Dimensions M5200: 10.0 H x 16.0 W x 15.5 D in.  
(25 H x 41 W x 40 D cm)

M5300: 10.0 H x 16.0 W x 15.5 D in. 
(25 H x 41 W x 40 D cm)

M5400: 18.2 H x 13.4 W x 6.7 D in. 
(46.2 H x 34.0 W x 17.0 D cm)

Table E.1  Instrument Specifications (Continued)

Feature Definition
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    E. M5200/M5300/M5400 Technical Specifications 
Lead Specifications

Weight M5200: 14.6 lb / 6.6 kg

M5300: 22.5 lb / 10.2 kg

M5400: 13.1 lb / 6.0 kg

Power 115–230 VAC, 50/60 Hz

Current M5200: 1 Amp

M5300: 1 Amp

M5400: 0.5 Amp

Temperature Operating: 0° to 50° C / 32° to 122° F

Storage: –25° to +70° C / –13° to 158° F

Relative Humidity  0–95% non-condensing

Table E.1  Instrument Specifications (Continued)

Feature Definition

Table E.2  Test Lead Specifications

Feature Definition

Test Lead Construction

Integrated three-lead 
system in single cable set

Standard ( 362 kV): 60 ft / 18 m

Optional (> 362 kV): 100 ft / 30 m
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PC Requirements

The M5200 and M5300 come with a carrying strap for easy transportation. 
The M5400 case has a handle.

Table E.3  PC Requirements

SFRA Instrument PC Requirement

M5200 and M5400 Minimum configuration: 

• Ethernet/USB
• Windows XP or Windows 7
• 500 MHz processor
• 256 MB RAM 
• 20 MB hard-drive free space
• DVD-RW

M5300 Built-in PC configuration:

• Windows XP
• Intel Celeron 1.3 GHz
• Minimum 512 MB RAM
• Minimum 40 GB HDD
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A

About command, defined A-9
Added Temporary Static-Discharge Grounds 

(screenshot) 3-13
Advanced Setup check box 3-21
Advanced Test Protocol section of Test Details 

window 3-21
Analysis tab A-17
antivirus software 3-4
Apparatus Selection Window (screenshot) 3-8, 

3-18
Apparatus tab A-19
autotransformer tests, setup B-3
auto-zoom of completed traces 3-10, 3-24

B

best practices for testing transformers 3-14
Blade in Top of Fuse Cover (screenshot) D-2
Browse for Folder Dialog Box  (screenshot) 

5-9

C

Cable and Lead Connections to the SFRA 
Instrument (figure) 3-2

Cable Connections for Shorted-Lead Test 
(figure) 3-9

Center Cursors command, defined A-7
clamps, plain copper, photo and part number 

1-4
Clear Traces command, defined A-9
cloning a transformer 5-6
Command Window Displaying IP Address 

(screenshot) 3-31
72A-2570-01    Rev. K    07/2011
communication cables
Ethernet crossover with part number 1-4
USB with part number 1-4

Confirm Installation Window (screenshot) A-3
Connect to Instrument Message (screenshot) 

3-3
Connected SFRA Leads (screenshot) 3-13
Connecting Safety Ground to Transformer 

(figure) 2-2
consistent testing setup, importance of 3-14
correct shorted-lead response 3-11
Correct Shorted-Lead Response (screenshot) 

3-11
CSV files for exported data 5-10
Cursor 1 command, defined A-7
Cursor 2 command, defined A-7

D

data
default storage locations for test results 5-8
managing 5-8
source files, selecting 5-9
transferring between M5300s or PCs 5-12

Data Manager tab 3-4, A-11
De-energized and Disconnected Transformer 

(screenshot) 3-12
deleting traces 5-11
DNS suffix for IP address 3-31
Doble Engineering shipping address D-3
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E

Edit Apparatus command, defined A-6
Edit Apparatus Option on Edit Menu 

(screenshot) 3-5, 3-15
Edit menu A-6
Edit Serial Number Dialog Box (screenshot) 

5-6
enet.m5200 DNS suffix 3-31
Entering a New Location (screenshot) 5-2
Entering a New Organization (screenshot) 5-4
Entering a New Serial Number (screenshot) 

5-3
Error 950 3-22
Error 951 3-22
Ethernet crossover cable

attaching 3-3
photo with part number 1-4

Exit command, defined A-6
export Location files 5-2
exporting

data to CSV files 5-10
location file 5-3
transformer file 5-7

F

File menu options, defined A-6
Files Converted Dialog Box (screenshot) 5-11
Find Instrument button 3-3
firewall 3-4
folders containing data, selecting 5-9
fuses, replacing D-1

G

Graph menu A-7
ground cables

safety ground, with photo and part number 
1-3

temporary static-discharge 3-12
grounding a transformer 3-12
grounding connection, example of 2-2

ground-loop resistance
18 m (60 ft) leads and acceptable values 

3-22
30 m (100 ft) leads and acceptable values 

3-22

H

Help menu A-9
HV Delta Winding Traces (screenshot) 3-26
HV delta winding, sample responses for three 

phases 3-26
HV side of a transformer, three sample short-

circuit responses 3-27
HV wye (star) winding, sample responses for 

three phases 3-27
HV Wye Winding Trace (screenshot) 3-27

I

Identifying an M5300 (screenshot) A-4
Impedance tab A-14
import Location files 5-2
importing

location file 5-3
location information from a results file 

5-11
transformer file 5-7
transformer information from a results file 

5-11
version 1.x and 2.x SFRA files 5-12

indicator lights on SFRA instrument 3-3
installing

SFRA 5.2 A-1
USB driver A-5

internal temperature test 3-22

L

leads
correct positioning of B-1
selecting correct length C-4
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specifications E-3
Legend pane A-10
length of test lead and how to select C-4
Linear command, defined A-8
locating an instrument 3-4
location data

importing from a results file 5-11
managing 5-1
settings file for 5-12

location file, importing and exporting 5-3
Location files, importing and exporting 5-2
Location of Fuses on M5400 (screenshot) D-1
Location of Select Test Button (screenshot) 

3-19
Location of Start Test Button (screenshot) 3-8, 

3-20
Log command, defined A-8
LTC position, recording B-2
LTC/DETC tab of Transformer Editor window 

(screenshot) 5-7

M

M5200
photograph 1-2
replacement parts D-3
safety requirements 2-1
specifications E-1

M5300
photograph 1-2
replacement parts D-5
safety requirements 2-1
specifications E-1

M5400
photograph 1-2
replacement parts D-3
safety requirements 2-1
specifications E-1

Magnitude tab 3-10, 3-24, A-12
measurement types, defined 3-1
merging settings files 5-14

N

New Range command, defined A-8

New Serial Number Listing (screenshot) 3-6
no instrument located 3-4
noise levels 3-22
Nonstandard Test Warning (screenshot) 3-21
nonstandard tests, performing 3-21

O

Open Fuse Cover with Fuses in Place 
(screenshot) D-2

Open-Circuit Lead Response (screenshot) 3-11
open-circuit measurement, defined 3-1
open-circuit response

diagnosing 3-25
sample 3-25

optional test lead photo and part number 1-3
Options command, defined A-6
organizations, settings file for 5-12

P

part numbers for replacement parts D-3
PC Requirements E-4
personnel safety 2-3
Phase tab A-13
Plot Property Dialog Box (screenshot) A-10
Plot Range dialog box (screenshot) A-8
Print command, defined A-6
Print Preview command, defined A-6
printing a report 5-16
Progress Bar in Installation Window 

(screenshot) A-3

R

Removed Isophase or GIS Link (screenshot) 
3-13

Removed Temporary Static-Discharge 
Grounds (figure) 3-14

repairs to SFRA instruments D-3
Repeat Results for One Phase (screenshot) 

3-29
replacement parts for SFRA instruments D-3
replacing a fuse D-1
Report Designer Window (screenshot) 5-17
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reports, configuring and printing 5-16
resistance between ground connections 3-22
Responses for One Phase of a Transformer 

HV Delta Trace (screenshot) 3-26
results see test results
RLC network measured by SFRA C-5

S

safety requirements 2-1
ground cable photo and part number 1-3
ground connection, example of 2-2
grounding instructions for transformers 

3-12
personnel 2-3

sample test results 3-25
saving traces 5-11
Select Apparatus command, defined A-7
Select Default Template Window A-4
Select Installation Folder Window 

(screenshot) A-2
Select Instrument window (Screenshot) 3-3
selecting a folder for viewing data 5-9
serial numbers of SFRA instruments, adding 

SFRA 5.2 database 5-3
settings files 5-12

merging 5-14
SFRA 1.x and 2.x, importing files from 5-12
SFRA 5.2 software

adding tap changer data 5-7
importing SFRA 1.x and 2.x files 5-12
installing A-1
measurement of RLC network C-5
organization information 5-4
RLC network measurement C-5
test instrument information 5-3
transformer information 5-5

SFRA instrument
cable connections 3-2
repairing D-3
replacement parts D-3
startup indicator lights 3-3

theory of operation C-1
SFRA testing, defined 1-1
shipping address of Doble D-3
Short Circuit Trace – Detail (screenshot) 3-28
short-circuit measurement, defined 3-1
short-circuit response, sample 3-25
Short-Circuit Test Trace (screenshot) 3-28
Shorted Turn on One Winding (screenshot) 

3-30
shorted turn sample responses 3-29
shorted-lead test

auto-zoom of traces 3-10
connections for measurement leads and 

reference grounds 3-9
correct response 3-11
open-circuit lead response 3-11
setting up and running 3-2

Shorted-Lead Test in Progress (screenshot) 
3-10

Simplified XML Transformer Settings File 
(screenshot) 5-13

standard test lead with photo and part number 
1-3

Start Menu (screenshot) 3-30
Start Test command, defined A-7
Status Bar (screenshot) A-12, A-13, A-14
Sub-Band tab A-15
Sweep Frequency Response Analyzer Settings  

(screenshot) 5-8
Sweep Frequency Response Analyzer Settings 

Dialog Box (screenshot) 5-9
system OK indicator light 3-3

T

tabs
Analysis A-17
Apparatus A-19
Data Manager A-11
Impedance A-14
Magnitude A-12
Phase A-13
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Sub-Band A-15
Tabulation A-18
Transformer 5-5
Waveform A-16

Tabulation tab A-18
tap changer data, adding to SFRA database 5-7
Template Editor window, opening 4-1
temporary static-discharge grounds 3-12
Test Details Dialog Box with Advanced Test 

Protocol (screenshot) 3-21
Test Details window 3-9

Advanced Test Protocol section 3-21
Test Equipment Editor 3-5, 3-16, A-19

opening 4-1
Test in Progress (screenshot) 3-24
Test in Progress indicator light 3-3
Test Init menu A-7
test leads

correct length C-4
correct positioning of B-1
described with pictures 1-3
optional, with photo and part number 1-3
specifications E-3
standard, with photo and part number 1-3

test results
default data storage locations 5-8
exporting to CSV files 5-10
representative samples 3-25
sample open-circuit responses 3-25
sample responses for one phase at different 

times 3-29
sample responses for three phases of HV 

delta winding 3-26
sample responses for three phases of HV 

wye (star) winding 3-27
sample short-circuit responses 3-25
sample short-circuit responses for HV side 

of a transformer 3-27
sample shorted turn response 3-29
troubleshooting 3-24

Test Selection Window (screenshot) 3-19
Test Setting Editor  (screenshot) 4-3
test settings

creating 4-4
editing and deleting 4-4

test templates
associate with a transformer 3-4
creating 4-2
defined 4-1
deleting 4-3
editing 4-3
managing tests in 4-3
settings file for 5-12

Test Templates Tab of Transformer Editor 
Window (screenshot) 3-7, 3-17

tests, managing in template 4-3
theory of operation for SFRA instruments C-1
three-winding transformers, test setup B-4
traces, saving and deleting 5-11
transferring data between M5300s or PCs 5-12
Transformer Editor window

LTC/DETC tab 5-7
Test Templates tab 3-7, 3-17
Transformer tab 3-6, 3-16

transformer files, importing and exporting 5-7
Transformer Settings File — User A 

(screenshot) 5-14
Transformer Settings File — User B 

(screenshot) 5-15
Transformer Tab of Transformer Editor 

Window (screenshot) 3-6, 3-16
TransformerNameplate Section of User B’s 

Settings File (screenshot) 5-16
transformers

adding to SFRA 5.2 database 3-6
adding to SFRA database 5-6
associate with a test template 3-4
cloning 5-6
good testing practices 3-14
grounding 3-12
importing data from a results file 5-11
RLC network C-5
settings file for 5-12
three-winding, test setup B-4
two-winding, test setup B-2
types of damage C-1

two-winding transformers, test setup B-2
Typical Open-Circuit Trace (screenshot) 3-25
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U

Unzoom command, defined A-8
USB

cable connections 3-3
cable with part number 1-4
driver, installing A-5

V

viewing data 5-9

W

Warning 952 3-22
Waveform Tab (screenshot) A-16
waveforms, monitoring 3-24
Welcome Window of Setup Wizard 

(screenshot) A-2
wye (star) winding typical response and later 

shorted-turn response 3-29

Z

Zoom command, defined A-8
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